Lab — Android Development Environment

Objectives:

Familiarize yourself with the Android Development Environment

Important Note: This class has many students with a wide range of previous experience. Some students
are fairly new to object-oriented (0O0) programming. Some have OO programming experience, but are
new to Android. Still others know some Android already, and want to just freshen up their knowledge.

Because of this, I’'m not expecting that everyone can finish this entire lab. | suggest that you set a time
limit for yourself, say 1 hour. Work through what you can in that time and then stop and take a break. If
you later feel that you have some more time for this Lab, then repeat the process. Again — don’t feel
that you need to finish everything in this lab. That’s not the goal here.

Specifically, if you are fairly new to programming, you should try to complete Parts 1 — 4 below. If you
are familiar with programming and programming environments, you should try to complete parts 1 - 6
below. If you’re an experienced programmer and reasonably comfortable with Java, try to do the whole
thing.

This lab contains the following Parts.

Set up the Android SDK.

Create a new Android application.

Create an Android Virtual Device and start the Android Emulator.
Run the application you created in Part 2.

Import an application project.

Debug an Android application.

Further explore the IDE
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Additional helpful information can be found on the Android Developer website:

* http://developer.android.com/sdk/installing/bundle.html

* http://developer.android.com/training/basics/firstapp/creating-project.html
* http://developer.android.com/tools/devices/managing-avds.html

* http://developer.android.com/training/basics/firstapp/running-app.html



Part 1 — Setting Up The SDK.

In this part you will download and install the Android SDK and start the Eclipse Integrated Development
Environment (IDE).

1.

Download the SDK from http://developer.android.com/sdk/index.html. Remember where you
save the downloaded file.

» Computer » DATA(D:) » Newfolder » v
Organize v Include in library v Share with v New folder
¢ Favorites | Name Type
Bl Desktop |1, adt-bundle-windows-x86_64-20131030 Compressed (zipp
j, Downloads

"2l Recent Places

4 Libraries
@ Documents
J Music

2. Double-click on the zip file you just downloaded to extract the zip file’s contents.

g o|B %
OO [+ Computer » + [43][ Search Computer o] ﬁ ;z 1) « Newfolder » adt-bundle-windows-x@6_64-20131030 » <[4
|| Organize v System properties  Unind™i o+ <hange s program  Map network drive. > =+ 0 © | e
: DsMoP  * L Hard Disk D S Name e
] Recent Places Local Dishy | 1. adt-bundle-windows~86_64-20131... _File folder
271 GB Hee o990 G S0 651 GB free of 831 GB & Downloads
4 Libraries + Copy to Local Disk (C:) % Recent Places
[ Documents ~
& Music - Libraries
(&5 Pictures [ Documents
Subversion < Musn(
B videos =) Pictures
- Subversion
& Homegroup B Videos
1% Computer & Homegroup
&, Local Disk (C:)
< DATA (D) - 18 Computer alal i




3. (Optional) Using Windows Explorer, drag and drop the ADT Bundle folder to any location you
designate.

&)=/ 1 « Newfolder » adt-bundie-windows-86_64-20131030 » o|[&

File Edit View Tools Help

Organize v Extract all files

. Favorites Name Type

Bl Desktop .. adt-bundle-windows-x86_64-20131... File folder
4 Downloads -

.
= Recent Places

- Libraries

Assuming you have the Java Development Kit installed on your computer, you should now be
able to use the Android SDK. If you do not have the Development Kit installed, see:
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html
for more information.

4. Start the Eclipse Integrated Development Environment (IDE). Begin navigating to the Eclipse
application by double-clicking on the ADT Bundle folder.

@ ‘. .. » Computer » DAA (D:) » New folder » v Search New folder pe

Organize v Include in library v Share with » New folder

T ~
=l RecentPlaces *  Name Type Date modified

| adt-bundle-windows-x86_64-20131030 File folder 12/23/2013 1:36 PM
‘ | 1) adt-bundle-windows-x86_64-20131030 Compressed (zipp... 12/23/20131:17 PM 491,930 KB

4 Libraries
:LE] Documents
J7 Music
[&=] Pictures
::ﬂ Subversion
# Videos

+& Homegroup

1% Computer
&, Local Disk (C3)
ca DATA (D)
l RawrMunster

2 items




5.

Next, double-click on the eclipse folder.

=r= <

i@ Homegroup

1% Computer

“ Local Disk (C:)

- DATA (D:)

' RawrMunster

‘ eclipse
‘ | File folder

-

Date modified: 12/23/2013 2:41 PM

6. Next, double-click on the eclipse application icon.

Organize v

New folder

OB | <« odtbundie-vindows-86. 640131030 » ecipse » < |4y || scornecpie P
Open

|« Newfolder » adt-bundle-windows-x86_64-20131030 » ~ |4 ||| Search adbundieswindows-x86.64-2.. o
Organize v & Open Include in library v Share with ¥ New folder 8= v [ 0
‘5l Recent Places  ~ Name Date modified Type Size
o | eclipse 12/23/2013 2:41 PM  File folder |
4 Libraries 1N -
1. sdk 12/23/2013 2:02 PM  File folder
@ Documents = -
. ‘"' SDK Manager 12/23/20131:35PM  Application 350 KB
J\ Music
[E=| Pictures
Subversion
B videos =

==

2] Recent Places

3 Libraries
@ Documents
J’ Music
[E5] Pictures
Subversion

Videos

+& Homegroup

1% Computer

E Local Disk (C:)

ca DATA (D)
l RawrMunster

e

eclipse

Application

-

v,

Name

. configuration
. dropins

.. features

. op2

.. plugins

.. readme

|| .eclipseproduct
| artifacts

Date modified

12/23/2013 2:41 PM
10/24/2013 2:22 PM
12/23/2013 1:35 PM
12/23/20131:35 PM
12/23/20131:36 PM
12/23/20131:35 PM
12/23/20131:35 PM
12/23/2013 1:35 PM

Type

File folder
File folder
File folder
File folder
File folder
File folder

ECLIPSEPRODUCT...

XML File

| e eclipse

12/23/20131:35 PM

Application

| eclipse
[ eclipsec
© epl-v10
@ notice

Date modified: 12/23/2013 1:35 PM

Size: 305 KB

12/23/20131:35 PM
12/23/20131:35 PM
12/23/20131:35 PM
12/23/20131:35 PM

Date created: 2/4/2013 5:05 AM

Configuration sett...

Application

Chrome HTML Do...
Chrome HTML Do...




7. As Eclipse starts, the Android Developer Tools splash screen will appear.

ANDROID

DEVELOPER
TOOLS

8. Eclipse will ask you to choose the location of your workspace. If you would like that workspace
to be the default from now on, select the appropriate checkbox.

{}) Workspace Launcher

Select a workspace

ADT stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: C:\Users\Username\workspace v

V]Use this as the default and do not ask again:




9. At this point you should see Eclipse open. The first time it opens you may see a Welcome screen,
such as the one shown below.

[© sava - 01 =
Eie Edit Refactor Nevigate Search Project Bun Window Help

5| @ Android DE =

0
m

& | Welcome!

g Android 2pps. This
is set up with of the Android platform and system image
I d running them

indroid, follow this class Android APIs for creating a

-, be sure you droid users expect

provides tools that help you test every aspect of your app to be sure it behaves as
us conditions,

svoisM D

Advanced - Using Hardware Acceleration. Student Ed B. reminded me to mention the Intel Hardware
Accelerated Execution Manager (HAXM). If compatible with your development machine, installing
HAXM will greatly speed up the emulator, making your development, testing and debugging much more
productive. HAXM is bundled with the ADT, and also available for download separately.

See the following links for more information:
http://developer.android.com/tools/devices/emulator.html#tacceleration for a complete description.

About: http://software.intel.com/en-us/articles/speeding-up-the-android-emulator-on-intel-
architecture

Downloads: http://software.intel.com/en-us/articles/intel-hardware-accelerated-execution-manager



Part 2 — Creating A New Project

In this part you will create a simple Android application that displays the words, “Hello World!”

1. From the application menu bar, select File > New > Android Application Project

| — —— - P R p—
File) Edit Source Navigate Search Project Refactor Run Window Help
New AleShifteN » | (5 Java Project ;;,. il
Openfile.. @ Android Application Project
Close cuiew |3 Project-.
Close Al Ctlsshift-W | 8 Package
cues | @ s
(1]
Cureshiftes |G En
@ Am
& So
=2
2 |05 Fo
a B |
Convert Line Delimiters To *| @ untited TecFie
Print Cut+p | [ Android XML File
7 JnitTest C
Switch Workspace )| E st Cose
Restart r9 Bample..
24 Impor. [ Other.. N
4 Export
Properties Alt+Enter
Eit
[ Problems @ Javadoc [3) Declaration [E) Console | ¥ LogCat 53
Sear <. Accepts Java regees. Prefx with pid, app tag:or text: to it sc
L. Tim PD T Application Tag

2. Next, a dialog box will appear, allowing you to enter an Application Name. Enter the string,
“MyFirstApp.” The Project Name and Package Name fields will fill in automatically. Leave the
remaining settings alone and then click Next.

' Y
@) New Android Application G |

New Android Application 4 \
1y The prefix 'com.example.’ is meant as a placeholder and should not be used

Application Name:® MyFirstApp|

Project Name:® MyFirstApp

Package Name:& com.example.myfirstapp

Minimum Required SDK:O[API 8: Android 2.2 (Froyo) v

Target SDK:QIAPI 18: Android 4.3 (Jelly Bean)

4

4

Compile With:O[API 18: Android 4.3 (Jelly Bean)

Theme: 6| Holo Light with Dark Action Bar -

» Theapplication name is shown in the Play Store, as well as in the Manage Application list in Settings.

©) T BT Eimis

L——T|




3. Next, a new dialog box will appear. Deselect “Create custom launcher icon,” as we will not be
creating a custom icon for this app. Then click Next.

;
@ New Android Application eSS

New Android Application iaby:
Configure Project

[7] Create custom launcher icon
Create activity

[] Mark this project as a library

Create Project in Workspace

Location: | C:\Users\Tintin\workspace-android\MyFirstApp Browse...

Working sets
[] Add project to working sets

Working sets: v Select...

@ [ <Back |[ Net> [ Ensh |[ Cancel

4. Inthe next window, leave all the settings as default. Then click Next.

-
o New Android Application @M
Create Activity e
Select whether to create an activity, and if so, what kind of activity.
Create Activity

Blank Activi
Fullscreen Activity
Master/Detail Flow

Blank Activity

Creates a new blank activity, with an action bar and optional navigational elements such as tabs or horizontal swipe.

@ <Back || Net> || FEnich




5. For the next window, also leave all default settings in place and press Finish.

@ New Android Application

Blank Activity
Creates a new blank activity, with an action bar and optional navigational elements such as tabs or

horizontal swipe.

(W~

Activity Name® MainActivity

Layout Name® activity_main

Navigation TypeOI None

» The name of the activity class to create

@ Next > [ Finish ] [ Cancel

6. Next, Find and press the restore icon on the left to bring the main editing window up.

@ Java - asdf/src/com/example/asdf/MainActivity.java - ADT F - a4 &
File Edit Source Navigate Search Project Refactor Run Window Help

= ©

elcome!

The Android Developer Tools provide a first-class development environment for building Android apps. This
integrated development environment is set up with the latest version of the Android platform and system image

so you can immediately begin building apps and running them on the Android emulator.

[ New Android Application...

Tutorials

Build Your First App If you're new to Android, follow this class to learn the fundamental Android APIs for creating a
responds to input.
Before you begin developing your app, be sure you understand the design patterns that Andro
from your app.
The Android Framework provides tools that help you test every aspect of your app to be sure it
expected under various conditions.

Design Your App

Test Your App




7. At this point, your screen should look similar to the one below. Open the MainActivity.java file

to see the code that sets up the Main Activity of your new app.

2 Problens @ Juadoc [ Decton @ Consle T LogCt 10

s b= |
g o )

Lo Tme ™ Appicaton T Tot

|t | Smatien__ 111

[rmose ) H &DID

| oo 6

=a

8. Under activity_main.xml, is the xml file associated with the layout of your Main Activity. If you

click on the Graphical Layout tab, you can see words, “Hello world!” appearing on the Activity’s

user interface.

TextView [Ab] Large Text
Medium Text 5] Small Text
Button [04] Small Button
[=] ToggleButton (/] CheckBox
(®) RadioButton
CheckedTextView

(] Spinner

B ProgressBar (Large)

I ProgressBar (Normal)

B ProgressBar (Small)

W ProgressBar (Horizontal)

W) SeekBar

I QuickContactBadge

[] RadioGroup ¥ RatingBar

() Text Fields
() Layouts

() Composite

() Images & Media
() Time & Date
() Transitions

() Advanced

() Other

() Custom & Library Views

) activity_mainxml zz' [3] MainActivity.java

< Palette —— ) o -
5 palete 21 B ~| @Newsone ~| B v| # AppTheme ~| @ Mainactiity | @ ~| G -
Cromwises ||(EHD ©E-

@ MyFirstApp

Hello world!

=0

QRaala’

2o

Graphical Layout| (= actvity_mainami

[ Problems @ Javadoc [, Declaration [E) Console ¥ LogCat 52

In part 4 we will show you how to run this app in the Android Emulator.
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Part 3 — Using the Emulator

In this part you will learn how to set up and use the Android Emulator.

1. First start up the Android Virtual Device Manager. You can do that by selecting Window >
Android Virtual Device Manager from the Eclipse menu bar.

[ eva - MyFistapp/res/iayoutiactvity mainami - ADT L T L e e e e

Eile Edit Source Navigate Search Project Refactor Run [ Window | Help

i AN O Qo vid Gy NewWindow
New Editor
£ Package Explorer 53 B hide Tootbar JsinActivityjava

> 35 DB Example

+ 12 DBReaderTest Open Perspective 21 @ -] BNewsone ~| B | # AppTheme ~| @ M

> 55 MainActivity Show View »
2
e v BE =E-|
s Customize Perspective... Text
4 8 com.examplemyfirstapp Save Perspective As... bl Text
> [1) MainActivity java Reset Perspective... - :
. € gen (Generated Java Files] —— piton ®! MyFirstApp
» A Android 4.3 . heckBox
Close All Perspectives
» = Android Private Libraries Hello world!
& assets Navigation » :
» & bin
» & libs Android SDK Manager
b & res & Android Virtual Device Manager
[dl AndroidManifestxml & Run Android Lint o
[2) proguard-project.txt Preferences )
[E] project.properties ooy

> 55 SensorLabvl
> 32 SensorLabv2
> &2 ServiceloggingWithMessenger W) SeekBar

» & ServiceLoggingWithMessengerClient .

, 53 ServiceMusicPlayerForegroundService B QuickContactBadge
» 42 TodoManager [Z] RadioGroup ¥ RatingBar
> & TouchLab

B ProgressBar (Horizontal)

() Text Fields

() Layouts

() Composite

() Images & Media
() Time & Date
() Transitions

() Advanced

() Other

2. Anew dialog box will pop up. Click “New” to create a new Android Virtual Device (AVD).

Android Virtual Device Manager S Swww

Android Virtual Devices | Device Definitions

List of existing Android Virtual Devices located at C:\Users\Tintin\.android\avd

AVD Name Target Name Platform API Level CPU/ABI New...
i+/ Phone Android 4.3 43 18 ARM (armeabi-v... :

Ed
c[Createsa

Delete...

| Repair...

Details...

Start...

Refresh

+ Avalid Android Virtual Device. -} A repairable Android Virtual Device.
€ An Android Virtual Device that failed to load. Click 'Details' to see the error.




3. Another dialog box will pop up displaying various AVD parameters. You can play with these

parameters to create different virtual devices. Press “Ok” to finish.

4. A new AVD will now be listed in the AVD Manager window. Select it and then press the Start

button.

AVD Name:

Device:
Target:
CPU/ABL

Keyboard:
Skin:

Front Camera:

Back Camera:

Internal Storage:

SD Card:

Emulation Options:

Memory Options:

Phone
[Nexus 5 4.0%, 480 x 800: hdpi) - |
[Android 43 - API Level 18 -

ARM (armeabi-v7a)
Hardware keyboard present
Display a skin with hardware controls

[Webcamﬂ ']
[WebcamO v]
RAM: 343 VM Heap: 32

0
© Size: 10

© File: Browse...

Snapshot [7] Use Host GPU

Override the existing AVD with the same name

[ ok ][ cancel

r
Android Virtual Device Manager

Android Virtual Devices | Device Definitions

List of existing Android Virtual Devices located at C:\Users\Tintin\.android\avd

AVD Name Target Name

Platform API Level CPU/ABI

i+ Phone Android 4.3

43 18 ARM (armeabi-v...

Repair...

Start...

[ Starts the se

Refresh

+ Avalid Android Virtual Device. -} A repairable Android Virtual Device.
€ An Android Virtual Device that failed to load. Click 'Details' to see the error.
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5. A new dialog box will pop up. Press the Launch button to start the emulator.

-
) Launch Options

)

Skin:  480x800
Density: High (240)
["] Scale display to real size
Screen Size (in): | 4.0
Monitor dpi: 96 ?
Scale: default
[ Wipe user data
[JiLaunch from snapshot
Save to snapshot
[ Launch ] [ Cancel

6. Asthe emulator starts up, you will see another dialog box. Launch errors will be displayed here.

-
 ° Starting Android Emulator

=

Starting emulator for AVD 'Phone'

J

Starting emulator for AVD 'Phone’

13



7. Next, The emulator will appear and start its boot sequence.

@ 5554Phone

| ﬁ
000

Hardware Buttons

8. After the device has booted, the emulator will be ready for user interaction.

@ 5554:Phone

15T

Connect your charger

ANDROID

SRAEE X

Basic Controls

o0 0

Hardware Buttons

Hardware Keyboard
Use your physical keyboard to provide input

14



Part 4 — Running Your First App

In this part you will learn how to run the application you created in Part 2 in the Android Emulator.

1. Return to Eclipse and right-click your app’s project name. From there select Run As > Android
Application.

[# Package Explorer 57 BHE Y= 0O | acivitymainxml 52 [J) MainActivity.java
g . .
» 55 DB Bxample <~ Palette —— »
» 55 DBReaderTest 3 Palette <] 9 " 0 News One " 8 "  AppTheme " © Maina
D
b 52 MainActivity =
(= Form Widgets - q
SEMT R B Form Widget O E8- @8
e (6] TextView [Ab] Large Text
Go Int
“ eme Medium Text (&) Small Text
Open in New Window - .
gp|  Ormintenine . Button (2] Small Button ®! MyFirstApp
b pen Type Hierarchy (=] ToggleButton [+/] CheckBox
b m ShowIn Alt+Shift=W » Cadiot )
& adioButton Hello world!
)6 Copy. Ctrl+C 8 CheckedTextView
& Copy Qualified Name &) spinner
b & Paste Ctrl+V -
a e ovile ProgressBar (Large)
B 8 ProgressBar (Normal)
Build Path »
uild e B ProgressBar (Small)
» 52 Sen  Source Alt+Shift+S » )
> ESSen | Refactor g W ProgressBar (Horizontal)
> & Seny W) SeekBar
< 2y Import...
b & Sen 1| TmP I QuickContactBadge
> 59 Sen 1y Bxport..
> 12 To [] RadioGroup ¥ RatingBar
42 Tol & Refresh s
Close Project
Close Unrelated Projects
Assign Working Sets... (O Text Fields
=
Run As »| [ 1 Android Application E
Debug As »| J& 2 Android JUnit Test u
Profile As » 3Java Applet AltsShift=X, A u
Validate [3] 4Java Application AltsShift+X, ) u
Team »| Ju 5 Uit Test Alt-Shift=X, T o
Coppast e Run Configurations... | |
Restore from Local History... T Castom & Tirary Vi "
Android Tool »
neroid Toe =] Graphical Layout | (=) activity_mainmi |
Translate Android Application »
Properties Alt+Enter [£1 Problems @ Javadoc [, Declaration [ Console ¥ LogCat 32
Resource Configurations »

Saved Filters # = B | [Search for messages. Accepts Java regexes. Prefix with pid:, app, tag: o

All messages (nofilters)

2. Inthe Console panel, below the editing window, you will see output indicating that the
application is being loaded onto the Android Emulator.

T Time & Date

() Transitions

() Advanced

() Other =

(] Custom & Library Views « D

Graphical Layout | =) ammy,mamml‘ -
[2. Problems @ Javadoc [€) Declaration [l Console 52 |3 LogCat EpiletB-r5-=0
Android

[2013-12 SDK Manager] hw.keyboard=yes =
[2013-12- SDK Manager] vm.heapSize=32

[2013-12- SDK Manager] hw.ramsize=343

[2013-12- yFirstapp]

[2013-12 MyFirstapp] Android Launch!

[2013-12 tapp] adb is running normally.

[2013-12 - MyFirstapp] Performing com.example.myfirstapp.MainActivity activity launch

[2013-12- - MyFirstapp] Automatic Target Mode: using existing emulator 'emulator-5554' running compatible AVD ‘Phone’

[2013-12- =

- MyFirstApp] Uploading MyFirstApp.apk onto device 'emulator-5554" E
- MyFirstapp] Installing MyFi Lapk...

B »




3. Return to your Emulator instance. If neessary, drag the lock icon to unlock your device.

@ 5554Phone

1:55

Connect your charger

Py )

Basic Controls

oo o0

DPAD

=7
ey

4. You should now see your application, running in the Android Emulator.

@ 5554:Phone

i MyFirstApp

Hello world!
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Part 5 — Importing and Running an Existing Application
In this part you’ll learn to import a pre-existing application into Eclipse and then run it.

1. Download the TheAnswer application.
2. Extract the contents of the Example App to any folder. The contents should contain
a sample project contained within a folder.

4 Downloads

% Recent Places

4 Libraries
£ Documents
& Music
=) Pictures
=)l Subversion
B videos

& Homegroup

s -
1item

i

1% Computer

4 Libraries
<| Documents
& Music
=] Pictures
=1l Subversion
B videos

& Homegroup
1% Computer
&, Local Disk (C)

s DATA (D)

€ Network

=]
@ <[00 » Computer » DATA (D) » Newfolder(2) » ~ [ 42| [ Search New folder (2 (). [ 1 « DATA(D) » Newfolder @) » TheAnswerbample » [ 43 || Search Theanswert
Organize v Include i library - Organize v Extract allfiles
- - Date rodified Type Size £l RecentPlaces  ~  Name Compressed size Password S|
¢ Favorites y
B Desktop KB TheAnswer

i

<

TheAnswer Date modified: 12/23/2013 2:07 PM

Type: File folder

3. Return to Eclipse. Select File > Import from the menu bar to import the application

project.

|) Java - ADT

-~

New

Open File...
Close
Close All
Save

Save As...
Save All

Revert

Move...
Rename...
Refresh

Convert Line Delimiters To

R

Print...

Switch Workspace
Restart

Import...
Export...

G &

Properties

Exit

1 MainActivity.java [MyFirstApp/src/...]
2 activity_mainxml [MyFirstApp/res/...]

Alt+Shift+N »

Ctrl+W
Ctrl+Shift+W

Ctrl+S

Ctrl+Shift+S

F2
F5
>

Ctrl+P

»

Alt+Enter

Edit Source Navigate Search Project Refactor Run Window Help
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4. Next, in the dialog box that appears, select Android > Existing Android Code Into
Workspace, and then press the Next Button.

[ @ Import L@g‘

Select

Select an import source:

type filter text

> (= General
(= Android
&5 Existing Android Code Into Workspace
> (= C/C++
> (= Git
> (= Install
> (= Run/Debug
> = Team
> (= XML

[N

@ < Back Next >

5. Next, you'll see a dialog box, allowing you to select the project to import. Press the
Browse... Button.

©

Import Projects

@ Select a directory to search for existing Android projects

Root Directory:

Projects:

Project to Import

New Project Name

[] Copy projects into workspace
Working sets

[T] Add project to working sets

YWarking set

@ Next > Einish Cancel

18



6. Select the location of the Example Application contents, and press OK.

Browse For Folder @

. Music -
. New folder

4 . Newfolder (2)

I 4\@. TheAnswer

#%. .settings

m

1 > 0 SVN
assets
libs

res

saee

src

Folder: TheAnswer

[ Make New Folder ] [ OK ] [ Cancel ]

7. Inthe next dialog box, make sure that you select “Copy projects into workspace”
and then click the Finish Button.

©

Import Projects

Select a directory to search for existing Android projects

Root Directory: D:\New folder (2)\TheAnswer Browse...
Projects:
Project to Import New Project Name Select All
D:\New folder (2)\TheAnswer TheAnswer

Deselect All

ey

[V]iCopy projects into workspace:
Working sets

[T] Add project to working sets

Select...

@ Next > [ FEinish ] [ Cancel




8. At this point the application should appear in the Project Explorer on the left side of

the IDE.

|&) Java - ADT

o~ -

File Edit Refactor Source Navigate Search Project Run Window Help

[2 Package Explorer 3 5% Y=0O
4 2 TheAnswer

=) Android 4.4
=) Android Private Libraries
@ src
&3 gen [
&5 assets
= bin

les]

& libs

& res

| AndroidManifestxml
4] ic_launcher-web.png
[5) proguard-project.tt
[2 project.properties

AE M dN B O Q-G ®@ Yy

Android

[2013-12-30 10:45:05 - TheA
[2013-12-30 10:45:06 -

& Console 52

wer] Unable to resol]
TheAnswer] Unable to resol

9. Right-click the folder go to Run As > Android Application

PR

LK

) [ [

®
o
3

)

nswer

New
GoInto

Open in New Window
Open Type Hierarchy
ShowIn

Copy
Copy Qualified Name
Paste
Delete

Build Path
Source
Refactor

Import...
Export...

Refresh

Close Project

Close Unrelated Projects
Assign Working Sets...

Run As

Debug As

Profile As

Validate

Team

Compare With

Restore from Local History...
Android Tools

Translate Android Application

Properties

Resource Configurations

F4
Alt+Shift+W »

Ctrl+C

Ctrl+V
Delete
»
Alt+Shift+S »
Alt+Shift+T »

Alt+Enter

3

@

b

=

=

1 Android Application
2 Android JUnit Test
3 Java Applet

4 Java Application

5 JUnit Test

Run Configurations...

Alt+Shift=X, A
Alt+Shift+X, )
Alt+Shift=X, T

rzors-T.

[2013-12-23 14:33:04 -
[2013-12-23 1. o!

105 -
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10. The Android Emulator will now open up and run the example application.

@ 5554:Phone

Al

TheAnswer

The answer to life, the
universe and everything is:

42




Part 6 — Debugging

In this part of the lab you will learn how to use the Eclipse debugger to debug the TheAnswer
application you imported in Step 5.

1. Double-click the TheAnswer.java file under src > course.examples.theanswer

4 == TheAnswer
. B, Android 4.3
. B\, Android Private Libraries
a (# src
4 f§ course.examples.theanswer
> [J] TheAnswer.java

> &E gen [Generated Java Files]
&L assets

. &= bin

. &2 libs

. > res

@ AndroidManifest.xml
B ic_launcher-web.png
|5 proguard-project.bdt
[E] project.properties

2. Next, open the Debugging Perspective by selecting Window > Open Perspective >
Debug from the menu bar.

Refactor Run [Window | Help
(% v @ J New Window

New Editor

= Hide Toolbar

wer/TheAnswerjava - ADT F oo Wy B -9 - q
-
ssramnloas k.,

Open Perspective » | @& DDMS

Show View » | ¥ Debug

Customize Perspective... E AT {
Save Perspective As... ety el iossio

Reset Perspective... Y et

Close Perspective Other...

BhCreate(BUNdIE savedInstancesS

Close All Perspectives o
nCreate(savedInstanceState);

Navigation >
entView(R.layout.answer_Layout);
Android SDK Manager
o ) w answerView = (TextView) findView
E Android Virtual Device Manager
[/ Run Android Lint » | = findanswer();
output = (val == answer) ? "42" :
Preferences

iew
.setText("The answer to life, the
+ output);

i




3. A new perspective will appear, similar to that shown below.

[0 5evos Trermmeey e e e 0T - - == - W =E
Fle Gt Sauce flocor Novgte Search Projct Fun WindowHelp

Sk &N I %+ 0~ -im P E e QuickAccs 21| & @ oovs (F5003)
5 0ubug 12 [# "= 5  wevobe st Pl EEREE]

AR e “=0D

Virable | Smanier | 14:44 simorssm [0

4. On this screen, double click the highlighted blue area next to the line:
“int val = findAnswer();”

setContentView(R.layout.answer_Layout);
TextView answerView = (TextView) findViewById(R.id.answer_view);

int val = findAnswer();
String output = (val == answer) ? "42" : "We may never know";
answerView
.setText("The answer to life, the universe and everything is:\n\n"
+ output);
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5. A new breakpoint will be placed at that line, indicated by the small circle that now
appears in the highlighted blue area to the left of the text.

setContentView(R.layout.answer_Llayout);

TextView answerView = (TextView) findViewById(R.id.answer_view);

|Line breakpoint:TheAnswer [line: 20] - onCreate(BundIe)i

String output = (val == answer) ? "42" : "We may never know";
answerView
.setText("The answer to life, the universe and everything is:\n\n"
+ output);

6. Next, press the Debug icon at the top of the window in the menu bar to start
debugging the application.

@ Debug - TheAnswer/src/course/examples/theanswer/TheAnswer.java - ADTi

File Edit Source Refactor Navigate Search Project Run Window Help

1w AN | = BEJo-a-i®y-iv o

[ Debug TheAnswer (already running) }

%5 Debug 52
TheAnswer [Android Application]
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Your Emulator should have loaded the App and stopped before the words ,“The

answer to life......” , is displayed on the screen.

=]

=

g

Quick hccess £ & e @ 00MS {:ma

@ s554hone

i

Al
TheAnswer.

SRR

Now that the app is stopped, you can examine the app’s state and step through the
app’s execution using the following buttons appearing in the menu bar.

|ub| I o i Y
3 4 5 6 7

Buttons from left to right on the navigation bar:
1-Resume

2 —Suspend

3 —Terminate

4 — Disconnect debugger from emulator
5—Step into

6 — Step over

7 — Step return

8 — Drop to frame

9 — Use step filters
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9.

10.

Next, press the Resume icon to continue executing the app. The app will finish
loading and will display the text.

- L s . 2w = icdl

Quick Acces 5 & e @ 00MS

BT S0 e Varsbles 17 Lo |eies “ =1

©
49 Thread [<10>
49 Thread (<9

e =
XX o)

6o®o 6

Lot

Swedfites + = B s,

Allmeszages no fiters

The next debugging task will have you create and display informational messages to
the LogCat panel, to help you better understand the application’s runtime behavior.
To generate these messages, you will use methods in the android.util.Log class. You
will also need to import this class into your application. Some LogCat functions
include:

1-Log.i(..., ...) — Sends an INFO LogCat message

2 —Log.d(..., ...) — Sends a DEBUG LogCat message
3 -Log.e(..., ...) — Sends an ERROR LogCat message
4 - Log.v(..., ...)— Sends a VERBOSE LogCat message

See http://developer.android.com/reference/android/util/Log.html for more
information.
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11. Return to the Java Editing Perspective by clicking the Java lcon in the top-right
corner.

R
Quick Access ‘ 55 | |8 Java | @ DDMS

r9ef ¥ = O

1

A ' S0 S
) 2k —| : AR

B

12. Import the android.util.Log library by typing, “import android.util.Log;” near the
beginning of the code for TheAnswer.java. You can also use the Organize Imports
function (Ctrl + Shift + 0 is the shortcut).

i s ERGE IR TR CRER SRR A he

[J] *TheAnswerjava 52

package course.examples.theanswer;

= import android.app.Activity;
import andreoid.os.Bundle;
Wi import android.util.log;|
import android.widget.TextView;

public class TheAnswer extends Activity

public static final int[] answers =
public static final int answer = 42

= @override




13. The Log class’ methods require a string called a Tag, which identifies the creator of
the message and can be used to sort and filter the messages when they are
displayed. Create a constant called TAG within the TheAnswer class, by typing,

”.n

“private final String TAG = “TheAnswer”;

[J] *TheAnswerjava 52

package course.examples.theanswer;

= import andreoid.app.Activity;
import android.os.Bundle;
import android.util.Llog;
import android.widget.TextView;

public class TheAnswer extends Activity {
private final String TAG = "TheAnswer";

public static final int[] answers = { 42, -10, 0, 100, 1000 };
public static final int answer = 42;

= Mverride

14. Use the Log.i() function to create and output a log message. Just before the line that

starts, “int val = ...” type in a new line: “Log.i(TAG, “Printing the answer to life”);”

@verride
e protected void onCreate(Bundle savedInstanceState) {
: super.onCreate(savedInstanceState);

setContentView(R.layout.answer_Layout);

TextView answerView = (TextView) findViewById(R.id.answer_view);
Log.i(TAG, "Printing the answer to life");

2 int val = findAnswer();
: String output = (val == answer) ? "42" : "We may never know";
answerView
.setText("The answer to life, the universe and everything is:\n\n"
+ output);
L }
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15. Save your changes.

@ Java - TheAnswer/src/course/exan

File

Edit Source Refactor

Navi

4 o - -— ‘ 4 o]
: j'“lﬁl@:inin:\:l
1= Pack Save (Ctrl+S)
16. Run the application.
(€I Androidivianirest.xml . setContentView(R.|
Pf Ni » 2
pr SW i TextView answerVi
5 72 Sensd Go Into | Log.i(TAG, "Print
i :“Z ?;9 int val = findAng
> &% iensc Open in New Window i String output = (|
> = Servig . i
15@ I Open Type Hierarchy F4 L answerView
p = Servig i .setText(|
N &9 Servid ShowIn Alt+Shift+W » | 4
T Troal o }
= ;P;e: i=| Copy Ctrl+C
b - . . .
o - private int findAnswe]
» m) Al 5= Copy Qualified Name for (int val : an
4 (s [ Paste Ctrl+V if (val == an
4 8 % Delete Delete } return v3
» @3 ée Build Path > ) return -1;
G@ as| Source Alt+Shift+S » }
b & bl Refactor Alt ShiftT »
b 2= lig
b & re{ g Import...
9] Aty Export...
R ic.
pr & Refresh
pr Close Project
N vd -
b J,Z Todol Close Unrelated Projects <
b & Toud Assign Working Sets...
Run As 4 1 Android Application
Debug As » | 55 2 Android JUnit Test B
Profile As > 3 Java Applet Alt+Shift+X, A
Validate [3] 4Java Application Alt+Shift+X, )
Team » | Ju  5)JUnit Test Alt+Shift+X, T
Somestelih i’ Run Configurations...
Restore from Local History...
Android Tools >
Translate Android Application >
Properties Alt+Enter
heAnswer Resource Configurations »
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17. Once the app is run, open the LogCat panel at the bottom of the Java Perspective.
Look for the search box, enter, “tag:TheAnswer” and hit Return. You will now see

the log message from the TheAnswer application in the LogCat panel.

[ Problems @ Javadoc [&) Declaration [ Console ¥ LogCat 53
Saved Filters +

All messages (no filters)
L. Time PD  TD  Application Tag Tet

system process

.Th
D 12-23 14:55:1... 1064 1064 dalvikvm Not late-enabling NI (already on)
(T (122318557577 Jo6s 1064 course.examples... . IheAnswer Printing the answer to life

Emulator without GPU emulation detected.

D 12-23 14:55 . 1064 1064 course.examples... gralloc_go...
T 12-23 14:55 2 Ma

293 system process . Displayed course.examples.theanswer/.TheAnswer: +958ms

85Mof205M (Il Launching TheAnswer

8

Search for messages. Accepts Java regexes. Prefix with pick, app:, tag: or text: to limit scope, HE DI
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Part 7 — Exploring the IDE

7.1 SCREENSHOTS - In this part of the lab you’ll experiment with different emulated devices
and take a screenshot. If necessary, return to Part 3, following the directions until you reach
this screen.

({3 Edit Android Virtual Devi h&
AVD Name: Phone
Device: [ Nexus S (4.0°, 480  800: hdpi) -
Target: [Android 43 - API Level 18 -
CPU/ABE ARM (armeabi-v7a)
Keyboard: Hardware keyboard present
Skin: Display a skin with hardware controls
Front Camera: [WebcamO V]
Back Camera: [Webcamﬂ ']
Memory Options: | pan; 343 VM Heap: 32

Internal Storage: 200
SD Card:
© Size: 10 -m

© File: Browse.

Emulation Options: Snapshot [] Use Host GPU

Override the existing AVD with the same name

r ok |[ cancel

1. This time around change the Device from the Nexus S to any other device, such as a
tablet or the Nexus 4.
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2. Once you’ve created the AVD, start the emulator.

@ 5554Phone

I keyboard to provide input

3. Once your emulator has loaded, take a screenshot of the emulated device. Navigate

to the DDMS Perspective of the development kit.

[@ sava- 0T

==

Fle Edt Souce Refactor Nevigate Search Project Run [Window] Help

E BE M- GNH-0-Q|  New
Ne

2 Package Bplorer 57

2 Theanswer

Hide Toolbar

OpenGL Trace View

& Console 52

otz

5 | E7ma) @ oows

=n
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4. Click on the Screen Capture button.

@ pows - aoT

Lo O

Ele Edt Navigate Se:

= 8 % Theass 27§ Hesp (5 Allocation Tracker % Network Statistcs s File Eplorer (@ Emulstor Control

D LogCat 32

Saved Fiter: +

Al messages (o fites)

| &

=n

=n

vebore ~] W 8 DT

5. The snapshot will appear in a separate window.

Device Screen Capture ===

Refresh | [ Rotate | [ Swe | [ Copy | [ Done

Captured image:

Make yourself at home

You can put your favorite apps here.

To see all your apps, touch the circle.
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6. Press Save to save the image to anywhere on your computer. You have now created

a screenshot of your android device.

Make yourself at home

You can put your favorite apps here.

To see all your apps, touch the circle.
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7. 7.2 TELNET - For this next part you’ll use telnet to change the network speed
configuration in the emulator. You will need to use Windows’ command prompt,
Mac OS X’s Terminal, or the Linux shell. (Pictures in these instructions will use
Wndows 7)

BN C:\Windows\system32\cmd.exe |ﬂ]ﬁ

8. Return to the Android DDMS Perspective in Eclipse to find the port the android
emulator is running on (It’s also in the title bar of the emulator).

|&) DDMS - ADT

File Edit Navigate Search Project Run Window Help

N Q2 v v v v v v
= v

@ Devices 2 #| 00| 22| G @ Yy Y= 8 P Theds 2

Name

4 emu Online TestDevic...
systermprlcess 369 8600 / 8700
com.android.sy 439 8601
android.proces: 545 8606
com.android.in 573 8607
com.android.pt 594 8608
com.android.se 607 8609
com.android.ex 638 8611
com.android.er 675 8612
com.android.la 739 8613
android.proces: 781 8615
com.android.cz 844 8616
com.android.de¢ 893 8617
com.android.pr 906 8618

com.android.m 935 8619




9. Return to the command line interface and enter “telnet localhost <your port>”. In
my case | entered “telnet localhost 5554”. If your computer doesn’t recognize
localhost, try 127.0.0.1 instead.

>

C:\Windows\system32\cmd.exe

C:\>telnet localhost 5554_

E=E——)

10. The console will display text indicating that you’re connected to the emulator.

7

Telnet localhost

Android Console:
OK

type

*help’ for a list of commands

lc:\[j -23-1\
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11. To set the network speed to EDGE, enter “network speed edge”. Afterwards, you

will see the response “OK”.

f ~
Telnet localhost l SRR X

Android Console: type ’help’ for a list of commands
OK

network speed edge

OK

12. Return to the emulator and open up the browser to “http://www.google.com” and
measure how long it takes for the page to fully load. The measurement doesn’t need
to be precise. After each time you load the page, clear the Browser’s cache by going

to the Browser’s menu button and selecting Settings> Privacy & Security > Clear
cache.

13. Return to the command line and this time switch the network speed to full. Do this

by entering “network speed full”

r

~
Telnet localhost |ﬂl&]

Android Console: type ‘help’ for a list of commands
OK

network speed edge

OK

network speed full

OK

37



14. Return to the emulator and open up the browser to “http://www.google.com” again
measuring how long the page takes too load, this time on full network speed.

15. Repeat steps 12-15 again four more times. What was the average load time under
each network speed? Does the emulator really seem to affect network speed?
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16.

7.5 Sending SMS Messages — For this part of the assignment you’ll be sending an
SMS message to your emulator through the command line. Return to the command

line and enter: “sms send <sender’s phone number> <message>"

Telnet localhost

type 'help’ for a list of commands

Android Console:

OK
sms send 1235550008 test sms through telnet
OK

17. In the emulator, you will receive a text message and see a notification for a text
message, from the phone number you entered with the message you entered.

® swsaveice

=
‘Messaglng 1 EXnewmessioe Q)

1235550000
test sms through telnet
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18. 7.4 Moadified Hello World - Remember the first app you made? Let’s return to that!

19. In this part you’ll modify the original “Hello world!” message of your first app. To do
this you need to modify the string value in \res\value\string.xml

[@ 572 - MyFrsthpplresfuatues/stringeaamt - OT EEr=
Ele Edt Refoctor Navgote Search Broject Bun Window Eielp
B0 U W I @y e Quick Access o | @) @ooms 8B &EIM g
> =0 [ s tymainsml 1) MeinActityjave (1 singsaan © =g E3 8 =0
Android Resources (default)
OO00O0BNOEADMM@aA: At
o You
e o you s
T}
v ]
) Resources| ) stingasml
& Console 32 WE|# Beriv=n0
OpentiL Tace view
1sMoi2ooM

20. Change the value of the string to "Hello world! My name is [yourname]."

e ] Quick Access
F e A activity_mainxml [5) MainActivity java d *stringsxml 52 =0 &
Android Resources (default)
Resources Elements ©OOOE ®E [M[F A:  Attributes for hello_world (String)
@Strings@, ith optional simple formatting, can be stored and retrieved as resources, You
© app_name (string) [ Add.. can add formatting to your string by using three standard HTML tags: b, i, and u. If you use
) action_settings (String)

an apostrophe or a quote in your string, you must either escape it or enclose the whole
® hello_world (String) [Remove... string in the other kind of enclosing quotes.

Cuw Neme hello_world

Value* Hello world! My name is Nonny|

[5] Resources | (= stringsaml

] Console 33
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21. Now run the app and see the change!

B sioee =

-
18 MyFirstApp

22. Now add support for another language such as Spanish! To do this, you’ll need to

create appropriate string file, run your app, change the emulator instance’s default

language to Spanish, and then run the app. Your Spanish string, could be: "Hola
Mundo! Me llamo [yourname]."

For more information, take a look at:
http://developer.android.com/training/basics/supporting-devices/languages.html
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23. 7.5 HierarchyView Tool - Use the HierarchyView tool (or the Dump View Hierarchy
to Ul Automator button in DDMS) to display and examine the user interface of the

default Calculator App in your AVD. To do this, start the emulator and open the

Calculator App. Be aware that some people report problems with this when running

on an actual device.

24. In Eclipse, open the DDMS Perspective, then select “Dump View Hierarchy to Ul
Automator” button, and select Calculator activity. Or use the hierarchyviewer

program from the command line.

) DDMS - MyFirstApp/res/values/strings.xml - ADT
File Edit Navigate Search Project Run Window Help
9~ QL~viy - - =2 - =
g Devices 2 ‘ o8| fTheds® B )
Name
4 B emulator-5554  Online Device [4....
system_process 375 8600
com.android.sy 443 8601
android.proces: 559 8606
com.android.in 579 8607
com.android.pl 599 8608
com.android.se 613 8609
com.android.pr 633 8610
com.android.ex 645 8611
com.android.er 670 8612
com.android.la 720 8613
com.android.m 758 8614
android.proces: 839 8615
com.android.de 863 8616
com.android.pr 939 8617
com.android.m 1025 8618
com.android.ce 1042 8619
com.android.ce 1074 8620
D LogCat 52
Saved Filters + Search for messages. Accepts Java regexes. Prefix with pid:, app;, tag: or text: to limit scope,
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25. A dialog box will appear as the hierarchy viewer does its work.

—5 =
Quick Accens 5| 8 sova (ETODNE) @ Hiearchy View
V Vo8B fhesus @ ® @ -8
Thresd updstes no enbled for eected cent
(ise toabarbutton to ensbe)
Progress normtion
o Operation in progress.
Obtaning deice srenshot
-n
‘Search for messages. Accepts Java regeces. Prefi with pic, app, tag: or 1ot 1o it scope. [vebose ~] H B(E) 4
L. Time BDTD  Applcstion Ty Tet -
snorsav [

26. Once it’s done, you'll see a screen such as the one shown below. See if you can use
the Hierarchy Viewer to answer the following questions:

¥ 0T [EER==
Fle ft Resctor Navgate Sexch e B Windon ey
- P R T R [ETR)© 0ovs @ Hierrcy Vi
v=n activty_mainaml [J) MsinActuityjava stingsaml | (@ dump_S609641956748335374 i 17 =)o =n
-
PTENTErTI

What is the height of the View tree (how many levels deep is the hierarchy)?
Examine the View showing the plus (+) button. What kind of View is its
parent? How many children Views does its parent contain? What is the
relative index (position) of the plus (+) button View within its parent?
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27. 7.6 DeskClock — Download the source code for DeskClock application. Study it and
try to answer the questions below. You don’t have to run this app. Just look at the

code.
a.

Unzip the file and then import the project into Eclipse. Don’t worry about any
compilation or syntax errors that might appear.

Open the project’s AndroidManifest.xml file. The file has tags corresponding
to all of the four fundamental component classes. Identify one instance of
each fundamental component. For each one, identify its corresponding
source code file and find the line of code that defines the class as a subtype
of one of the fundamental components (e.g., class X extends Activity, class Y
extends Service, etc.)

Look in the res directory for this application. How many layout directories are
there? Which specific device sizes and/or orientations would use each of the
different layout directories you’ve found. For help with this problem you
could read the following blog post:
http://android-developers.blogspot.com/2011/07/new-tools-for-managing-
screen-sizes.html

Look again in the res directory. How many different values directories are
there? Find two examples of resource strings that can be configured for
different languages.

Look at R.java file that was generated for this application. There is a field in
the id class called “cities”. In which function and class does this field get
used? How is it referenced in the application code? Hint: Use Eclipse's Open
Call Hierarchy feature.
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28. 7.7 LogCat — Download the source code for WikiNotes application and run the
application. For this task, you’ll be familiarizing yourself further with LogCat.
a. Using the Logcat feature of DDMS, filter out messages relating to the
WikiNotes application.

B

5| 8 (G0 e

ka0 n2olwa@ VTS B HThed 2 ] -

D A

¥ LogCat 5 =0

messages. Accepts ava regexes. Prefix with pid:, app, tags ortext o lmit scope. HE@D:

LTMof323m [

b.

What is the log tag used by this application’s main Activity? Where do you
see that in the application’s source code?

What is the message associated with the first Log entry emitted when this
application starts running? For more information, read the following
webpage:
http://developer.android.com/tools/debugging/debugging-log.html
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29. 7.8 Heap View — Use DDMS to view heap usage for the WikiNotes process. In the

Devices tab, select the WikiNotes process (com.google.android.wikinotes). And click

the Update Heap button.

() DDMS - ADT
File Edit Navigate Search Project Run Window Help
C= QIR I
@ Devices 32 tl@@;@|%‘§,§|@|@ lla|"1'l/' ¥ =9
4 @ emulator-5554 Online Device [4....
system_process 374 8600
com.android.systemui 424 8601
com.android.inputmethod.latin 490 8606
com.android.settings 503 8607
com.android.phone 510 8608
com.android.launcher 532 8609
com.android.printspooler 554 8610
android.process.acore 583 8611
com.android.music 720 8612
android.process.media 803 8613
com.android.providers.calendar 822 8614
com.android.mms 852 8615
com.android.calendar 885 8617
com.android.deskclock 904 8618
com.android.defcontainer 923 8619
com.android.email 940 8620
com.android.exchange 966 8616
» com.google.android.wikinotes 997 8621 / 8700
COM.SVOX.pico 1037 8622

a. Inthe Heap tab, click CauseGC to enable the collection of heap data.
EDDMS—ADT
File Edit Navigate Search Project Run Window Help
[Shd Qe igvi- sl
8 Devices 51 ¥@x06/s2 o c @ry “=08| 3 Hep 2 6 °
4 B emulator-5554 Online Device [4.. D HeapSze Allocated Free %Used = Objects
system_process. E 8600 <
«com.android.systemui 424 8601
«com.android.inputmethod.latin 490 8606
id. 503 8607 Display: |Stats v
510 8608 Type Count Total Size Smallest Largest Median Average
532 8609
583 8611
android.process.media 803 8613
«com.android.providers.calendar 82 8614
‘com.android.mms 852 8615
com.andr 885 8617
904 8618
com.android.exchange 966 8616 Allocation count per size
com.google.android.wikinotes 997 @ s621/8700 10
com.svox.pico 1037 8622 09
08
07
‘g‘DS
BT
i
u
02
01
00

b. How many objects have been created?
c. Which type of Object has by allocated most frequently?
d. How much memory has been allocated for this type of Object?
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30. 7.9 Method Profiling - Use DDMS to view method execution sequences for the
WikiNotes process. In the Devices tab, select the WikiNotes process and then click
the Start Method Profiling button.

[& poms - apT
File Edit Navigate Search Project Run Window Help
. Qi e
@ Devices 32 1k |& ] | 3 ¥ =8
Name
4 B emulator-5554 Online Device [4....
system_process 374 8600
com.android.systemui 424 8601
com.android.inputmethod.latin 490 8606
com.android.settings 503 8607
com.android.phone 510 8608
com.android.launcher 532 8609
com.android.printspooler 554 8610
android.process.acore 583 8611
com.android.music 720 8612
android.process.media 803 8613
com.android.providers.calendar 822 8614
com.android.mms 852 8615
com.android.calendar 885 8617
com.android.deskclock 904 8618
com.android.defcontainer 923 8619
com.android.email 940 8620
com.android.exchange 966 8616
com.google.android.wikinotes 997 8621 /8700
COM.SVOX.pICO 1037 8622

Interact with the WikiNote application.

(@ ssseveice o

Testing the appi

Confirm Cancel




and then click the Stop Method Profiling button.

[@ powms - apT

File Edit Navigate Search Project Run Window Help
" LRy AT

g Devices 2 ik | @ O | %},

Name

4 B emulator-5554 Online Device [4....
system_process 374 8600
com.android.systemui 424 8601
com.android.inputmethod.latin 490 8606
com.android.phone 510 8608
com.android.launcher 532 8609
android.process.acore 583 8611
com.android.providers.calendar 822 8614
com.android.calendar 885 8617
com.android.deskclock 904 8618
com.android.defcontainer 923 8619
com.android.email 940 8620
com.svox.pico 1037 8622
com.android.packageinstaller 1097 8623
com.android.keychain 1119 8621
com.google.android.wikinotes 1290 8607 /8700

Your screen should look something like this:

[rwbore <] H &[0 &
i

a. Look at the profile panel. Find a method that is part of the WikiNotes

application (it’s in the com.google. android.wikinotes package).

What is the name of the method?
In what file is the source code for this method?

d. What are the exclusive real time and the inclusive real time spent in this

method? Why are they different?
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31. 7.9 Debugging and JUnit Testing — Download the source code for the simple
calculator application with corresponding JUnit Test project at:
http://code.google.com/p/simple-calc-unit-
testing/downloads/detail?’name=FullCodeDownload.zip&can=2&q= (Note — you may
need to download a new API level package for this app, using the SDK manager.)

32. Import the two projects into eclipse and run the SimpleCalcTest app in the emulator.

Unit Testing Sample

Enter value...

Enter value two...

Result:

Add Values | Multiply Values

simplecatc

33. Set a breakpoint at the line 91 (Function testSubtractValues() of
MathValidation.java) and start Debugging the project.

49



34. Also try debugging the app with Android JUnit Tests. Right-click > Debug As >
Android JUnit Test.

Java - SimpleCalcTest/src/ icle/si idationjava - ADT
ile Edit Source Refactor Navigate Search Project Run Window Help
5~ » 3 EE VMY N B O HFCEG (™Y - - S v | =
ackage Explorer 52 | gfu JUnit S-S J] MathValidation java 52
Package Explorer 52 | gfu JUs = 8 | [} MathValidationjava 53
» & MyFirstApp private static final String ADD_NEGATIVE RESULT = "52";
4 & simpleCalc private static final String MULTIPLY RESULT = "1776";
g ?‘“A"dm'“"‘ public void testAddvalues() {
4 (@ src / we use sendKeys instead of setText so it goes through entry
4 com.mamlambo.article simplecalc validation
> [3] MainActivityjava sendKeys (NUMBER_24) ;
4 @8 gen [Generated Java Files // now on value2 entry

o NUMBER_74);
4 8 com.mamlambo.article simplecalc sendKeys (NUMBER_74)

1) BuildConfigjava / now on Add button
> [9) Rjava sendKeys ("ENTER") ;

// get result

String mathResult = result.getText().toString();

assertTrue("Add result should be 98 " + ADD RESULT + " but was "
+ mathResult, mathResult.equals(ADD_RESULT));

) AndroidManifestxml }

[2) project.properties
+ [ Simple———s = public void testAddDecimalvalues() {
A New » sendKeys (NUMBER_5_DOT_5 + NUMBER_74 + "ENTER");
4 B srq Golnto String mathResult = result.getText().toString();
Pyl 3 r— assertTrue("Add result should be " + ADD_DECIMAL_RESULT + " but was "
. penin New Wincow: + mathResult, mathResult.equals(ADD_DECIMAL_RESULT));
. Open Type Hierarchy F }
Sowi im0 public void testSubtractValues() {
2 [y - sendKeys (NUMBER_NEG_22 + NUPBER_74 + "ENTER");
£ Copy Qualified Name String mathResult = result.getText().toString();
= paste G assertTrue("Add result should be " + ADD_NEGATIVE RESULT + " but was "
= + mathResult, mathResult.equals(ADD_NEGATIVE RESULT));
K Delete Delete }
Build Path »
Source AltsShiftsS > public void testMultiplyValues() {
sendKeys (NUMBER_24 + NUMBER_74 + " DPAD_RIGHT ENTER");
Refactor Alt+Shift+T »
String mathResult = result.getText().toString();
2 Import.. assertTrue("Multiply result should be " + MULTIPLY RESULT + " but was "
A |[Eport— + mathResult, mathResult.equals(MULTIPLY_RESULT));
}
& Refresh }
Close Project <
Close Unrelated Projects
Assign Working Sets... [%. Problems @ Javadoc [} Declaration [EJ Console ¥ LogCat 53
Run As 0 d Filters C A
2AVEC Search for messages. Accepts Java regexes. Prefix with pid:, app:, tag: or text: to limit scop|
Debug As »| [ 1 Android Application
Profile As » | 3§ 2 Android JUnit Test L.. Time PID TID Application Tag
Validate = 3 Android Native Application D 01-03 03:0 1069 1069 com.memlambo.ar... grallec_gq
Team »| E 4Java Applet Alt+Shift+D, A I 01-03 11 1180 1193 com
Compare With y | 5Java Application Alt+Shift+D, )
) ; I 01-03 11:3 1180 1193
Restore from Local History... Ju  6JUnit Test Alt+Shift+D, T
Android Tools o Debug Configurations... I 01-03 11:38:2... 1180 1193 com.mamlambo.ar...
Properties Alt+Enter
impleCalcTest Resource Configurations >

35. Step in the function, debug it and use the watch windows to keep track of the value
of the variable “mathResult.” Then please try to answer the following questions.

a. What are the values of “mathResult” before and after line 94?
b. Isthe later value a correct value?
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